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Important Information

Warranty
The GPIB hardware is warranted against defects in materials and workmanship for a period of two years from the date 
of shipment, as evidenced by receipts or other documentation. National Instruments will, at its option, repair or replace 
equipment that proves to be defective during the warranty period. This warranty includes parts and labor. 

The media on which you receive National Instruments software are warranted not to fail to execute programming 
instructions, due to defects in materials and workmanship, for a period of 90 days from date of shipment, as evidenced 
by receipts or other documentation. National Instruments will, at its option, repair or replace software media that do 
not execute programming instructions if National Instruments receives notice of such defects during the warranty 
period. National Instruments does not warrant that the operation of the software shall be uninterrupted or error free.

A Return Material Authorization (RMA) number must be obtained from the factory and clearly marked on the outside 
of the package before any equipment will be accepted for warranty work. National Instruments will pay the shipping 
costs of returning to the owner parts which are covered by warranty.

National Instruments believes that the information in this manual is accurate. The document has been carefully 
reviewed for technical accuracy. In the event that technical or typographical errors exist, National Instruments reserves 
the right to make changes to subsequent editions of this document without prior notice to holders of this edition. The 
reader should consult National Instruments if errors are suspected. In no event shall National Instruments be liable for 
any damages arising out of or related to this document or the information contained in it.

EXCEPT AS SPECIFIED HEREIN, NATIONAL  INSTRUMENTS MAKES NO WARRANTIES, EXPRESS OR IMPLIED, AND 
SPECIFICALLY DISCLAIMS ANY WARRANTY OF MERCHANTABILITY  OR FITNESS FOR A PARTICULAR PURPOSE. 
CUSTOMER’ S RIGHT TO RECOVER DAMAGES CAUSED BY FAULT OR NEGLIGENCE ON THE PART OF NATIONAL  
INSTRUMENTS SHALL BE LIMITED  TO THE AMOUNT THERETOFORE PAID BY THE CUSTOMER. NATIONAL  INSTRUMENTS 
WILL  NOT BE LIABLE  FOR DAMAGES RESULTING FROM LOSS OF DATA, PROFITS, USE OF PRODUCTS, OR INCIDENTAL OR 
CONSEQUENTIAL DAMAGES, EVEN IF ADVISED OF THE POSSIBILITY THEREOF. This limitation of the liability of National 
Instruments will apply regardless of the form of action, whether in contract or tort, including negligence. Any action 
against National Instruments must be brought within one year after the cause of action accrues. National Instruments 
shall not be liable for any delay in performance due to causes beyond its reasonable control. The warranty provided 
herein does not cover damages, defects, malfunctions, or service failures caused by owner’s failure to follow the 
National Instruments installation, operation, or maintenance instructions; owner’s modification of the product; 
owner’s abuse, misuse, or negligent acts; and power failure or surges, fire, flood, accident, actions of third parties, 
or other events outside reasonable control.

Copyright
Under the copyright laws, this publication may not be reproduced or transmitted in any form, electronic or mechanical, 
including photocopying, recording, storing in an information retrieval system, or translating, in whole or in part, 
without the prior written consent of National Instruments Corporation.

Trademarks
CVI™, HS488™, LabVIEW™, NAT4882™, natinst.com™, NI-488™, NI-488.2™, NI-488.2M™, TNT4882™C, 
and Turbo488™ are trademarks of National Instruments Corporation.

Product and company names listed are trademarks or trade names of their respective companies.

WARNING REGARDING MEDICAL AND CLINICAL USE OF NATIONAL INSTRUMENTS PRODUCTS
National Instruments products are not designed with components and testing intended to ensure a level of reliability 
suitable for use in treatment and diagnosis of humans. Applications of National Instruments products involving 
medical or clinical treatment can create a potential for accidental injury caused by product failure, or by errors on the 
part of the user or application designer. Any use or application of National Instruments products for or involving 
medical or clinical treatment must be performed by properly trained and qualified medical personnel, and all traditional 
medical safeguards, equipment, and procedures that are appropriate in the particular situation to prevent serious injury 
or death should always continue to be used when National Instruments products are being used. National Instruments 
products are NOT intended to be a substitute for any form of established process, procedure, or equipment used to 
monitor or safeguard human health and safety in medical or clinical treatment.
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This equipment generates and uses radio frequency energy and, if not installed and used in stric
accordance with the instructions in this manual, may cause interference to radio and television 
reception. Classification requirements are the same for the Federal Communications Commissio
(FCC) and the Canadian Department of Communications (DOC). The FCC/DOC classification is
indicated on a label on the devices. If an FCC ID is present, the equipment is Class B; otherwise
Class A. Look at the product to determine the classification, then read the appropriate information b
regarding the compliance of your product:

Class A

Federal Communications Commission
This equipment has been tested and found to comply with the limits for a Class A digital device, 
pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection a
harmful interference when the equipment is operated in a commercial environment. This equipm
generates, uses, and can radiate radio frequency energy and, if not installed and used in accordan
the instruction manual, may cause harmful interference to radio communications. Operation of th
equipment in a residential area is likely to cause harmful interference in which case the user will
required to correct the interference at his own expense.

Canadian Department of Communications
This Class A digital apparatus meets all requirements of the Canadian Interference-Causing Equi
Regulations.
Cet appareil numérique de la classe A respecte toutes les exigences du Règlement sur le matér
brouilleur du Canada.

Class B

Federal Communications Commission
This equipment has been tested and found to comply with the limits for a Class B digital device, 
pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection a
harmful interference in a residential installation. This equipment generates, uses and can radiate
frequency energy and, if not installed and used in accordance with the instructions, may cause h
interference to radio communications. However, there is no guarantee that interference will not o
in a particular installation. If this equipment does cause harmful interference to radio or televisio
reception, which can be determined by turning the equipment off and on, the user is encouraged
to correct the interference by one or more of the following measures:

• Reorient or relocate the receiving antenna.

• Increase the separation between the equipment and receiver.

• Connect the equipment into an outlet on a circuit different from that to which the receiver is 
connected.

• Consult the dealer or an experienced radio/TV technician for help.

Canadian Department of Communications
This Class B digital apparatus meets all requirements of the Canadian Interference-Causing Equi
Regulations.
Cet appareil numérique de la classe B respecte toutes les exigences du Règlement sur le matér
brouilleur du Canada.
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FCC Notices to User
Changes or modifications not expressly approved by National Instruments could void the user’s 
authority to operate the equipment under the FCC Rules.
This device complies with the FCC rules only if used with shielded interface cables of suitable qua
and construction. National Instruments used such cables to test this device and provides them for 
to the user. The use of inferior or nonshielded interface cables could void the user's authority to 
operate the equipment under the FCC rules.
If necessary, consult National Instruments or an experienced radio/television technician for addit
suggestions. The following booklet prepared by the FCC may also be helpful: Interference to Ho
Electronic Entertainment Equipment Handbook. This booklet is available from the U.S. Governm
Printing Office, Washington, DC 20402.



© National Instruments Corporation vii Plug and 
Contents
.xi
xii
xiii
.xiv
.xiv

1-1
.1-2
1-2
1-2
1-3
1-4

2-1
-1
-3
-4
2-5
2-5
2-6
About This Manual
How to Use the Manual Set ............................................................................................
Organization of This Manual ...........................................................................................
Conventions Used in This Manual...................................................................................
Related Documentation...................................................................................................
Customer Communication ..............................................................................................

Chapter 1
Introduction

How to Use This Manual .................................................................................................
What You Need to Get Started .......................................................................................
Optional Equipment .........................................................................................................
Plug and Play GPIB Hardware Overview........................................................................
GPIB Software Overview ................................................................................................
Time-Saving Development Tools ....................................................................................

Chapter 2
Installation and Configuration

Install the Plug and Play GPIB Software.........................................................................
Install the AT-GPIB/TNT(PnP) or PCI-GPIB Hardware ................................................2
Install the PCMCIA-GPIB Hardware ..............................................................................2
Install the NEC-GPIB/TNT (PnP) Hardware ..................................................................2
Configure the GPIB Software..........................................................................................

Resolve Conflicts...............................................................................................
Assign an Interface Name .................................................................................
View or Modify Logical Device Templates (Optional) ....................................2-7

Chapter 3
Verify the Installation
Play GPIB for Windows 98/95



Contents

-1
-1
2
-3
-3
. 4-4

A-1
-2

-1
1
1
1

-1
2
2
C-2
-3
-3

-3
-4
-4
-4
C-5
C-5
-6
-6
Chapter 4
Begin to Use the GPIB Software

Getting Started with LabVIEW....................................................................................... 4
Getting Started with LabWindows/CVI .......................................................................... 4
Introduction to the Win32 Interactive Control Utility..................................................... 4-
Introduction to the NI Spy Utility ................................................................................... 4
Running Existing DOS GPIB Applications .................................................................... 4
General Programming Considerations ...........................................................................

Appendix A
Uninstalling the Hardware and Software

Uninstalling the Plug and Play GPIB Hardware .............................................................
Uninstalling the GPIB Software...................................................................................... A

Appendix B
Forcing Windows to Detect the GPIB Hardware

Appendix C
Troubleshooting and Common Questions

Troubleshooting EDVR Error Conditions....................................................................... C
EDVR Error Condition with ibcntl Set to 0xE028002C (-534249428)............ C-
EDVR Error Condition with ibcntl Set to 0xE0140025 (-535560155) ............ C-
EDVR Error Condition with ibcntl Set to 0xE0140035 (-535560139) ............ C-
EDVR Error Condition with ibcntl Set to 0xE0320029 (-533594071) or 

0xE1050029 (-519765975) ............................................................................ C
EDVR Error Condition with ibcntl set to 0xE0140004 (-535560188) ............. C-
EDVR Error Condition with ibcntl set to 0xE1030043 (-519897021) ............. C-

Troubleshooting Device Manager Problems...................................................................
No National Instruments GPIB Interfaces Item................................................ C
Missing GPIB Interface .................................................................................... C
GPIB Interface Not Working Properly ............................................................. C

Troubleshooting Diagnostic Utility Failures ................................................................... C
Missing Software Components ......................................................................... C
No Properly Configured GPIB Interfaces Found.............................................. C
GPIB Cables Need to Be Disconnected............................................................
Address Resource Conflict................................................................................
Interrupt Resource Conflict............................................................................... C
DMA Resource Conflict ................................................................................... C
Plug and Play GPIB for Windows 98/95 viii © National Instruments Corporation



Contents

-6
C-7
C-7
.C-7

.D-1
..D-5

8

-2
3

3

5

Single-Cycle DMA Required ............................................................................C
GPIB Software Problem Encountered...............................................................
Unknown Problem Encountered........................................................................

Common Questions.........................................................................................................

Appendix D
Specifications

Hardware Characteristics ................................................................................................
Software Transfer Rates.................................................................................................

Appendix E
Customer Communication

Glossary

Figures
Figure 2-1. Installing the AT-GPIB/TNT (PnP).......................................................2-2
Figure 2-2. Inserting the PCMCIA-GPIB.................................................................2-3
Figure 2-3. GPIB Interface That Is Working Properly.............................................2-5
Figure 2-4. GPIB Interface That Is Not Working Properly......................................2-6
Figure 2-5. GPIB Settings Page for the AT-GPIB/TNT (PnP) ................................2-7
Figure 2-6. Device Templates Page for the Logical Device Templates...................2-

Figure 3-1. Diagnostic Utility after Testing .............................................................3-1

Figure A-1. Selecting an Interface to Remove ..........................................................A
Figure A-2. Add/Remove Programs Properties Dialog Box .....................................A-

Figure C-1. GPIB Interface That Is Not Working Properly......................................C-3

Tables
Table D-1. AT-GPIB/TNT (PnP) Hardware Characteristics ...................................D-1
Table D-2. NEC-GPIB/TNT (PnP) Hardware Characteristics ................................D-2
Table D-3. PCI-GPIB Hardware Characteristics .....................................................D-
Table D-4. PCMCIA-GPIB Hardware Characteristics ............................................D-4
Table D-5. GPIB Software Transfer Rates for the Plug and Play 

GPIB Hardware......................................................................................D-
© National Instruments Corporation ix Plug and Play GPIB for Windows 98/95



© National Instruments Corporation xi Plug and P
About
This

Manual
re. 
), 

nd 

ins 
GPIB User
Manual for

Windows 95
and Windows NT

Application
Development
and Examples

NI-488.2M Function
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for Win32
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and Routine
Descriptions

Novice
Users

Experienced
Users

Getting Started
Manual

Installation and
Configuration

This manual contains instructions to help you install and configure 
the National Instruments Plug and Play GPIB hardware and softwa
The Plug and Play GPIB hardware includes the AT-GPIB/TNT (PnP
PCI-GPIB, PCMCIA-GPIB, and NEC-GPIB/TNT (PnP). 

How to Use the Manual Set

Use this getting started manual to install and configure your Plug a
Play GPIB hardware and software.

Use the GPIB User Manual for Win32 to learn the basics of GPIB and 
how to develop an application program. The user manual also conta
debugging information and detailed examples.

GPIB User
Manual for

Win32

Application
Development
and Examples

Novice
Users

Experienced
Users

NI-488.2M Function
Reference Manual

for Win32

Function
and Routine
Descriptions

Getting Started
Manual

Installation and
Configuration
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Use the NI-488.2M Function Reference Manual for Win32 for specific 
NI-488 function and NI-488.2 routine information, such as format, 
parameters, and possible errors.

Organization of This Manual
This manual is organized as follows:

• Chapter 1, Introduction, explains how to use this manual, lists wha
you need to get started, provides an overview of the Plug and P
GPIB hardware and software, and describes optional equipmen
you can order. 

• Chapter 2, Installation and Configuration, describes how to install 
and configure the Plug and Play GPIB hardware and software.

• Chapter 3, Verify the Installation, describes how to verify the 
hardware and software installation.

• Chapter 4, Begin to Use the GPIB Software, helps you get started 
with the GPIB software.

• Appendix A, Uninstalling the Hardware and Software, describes 
how to uninstall your Plug and Play GPIB hardware and softwa

• Appendix B, Forcing Windows to Detect the GPIB Hardware, 
contains instructions to help you install your GPIB interface if 
Windows has not detected it properly.

• Appendix C, Troubleshooting and Common Questions, describes 
how to troubleshoot problems and answers some common 
questions.

• Appendix D, Specifications, describes the physical characteristic
of the GPIB hardware, the transfer rates of the GPIB software, a
the recommended operating conditions.

• Appendix E, Customer Communication, contains forms you can 
use to request help from National Instruments or to comment on 
products and manuals.

• The Glossary contains an alphabetical list and a description of 
terms used in this manual, including abbreviations, acronyms, 
metric prefixes, mnemonics, and symbols.
Plug and Play GPIB for Windows 98/95 xii © National Instruments Corporation
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Conventions Used in This Manual
This manual uses the following conventions:

» The » symbol leads you through nested menu items and dialog box
options to a final action. The sequence File»Page Setup»Options» 
Substitute Fonts directs you to open the File menu, select the Page 
Setup item, select Options, and finally select the Substitute Fonts 
option from the last dialog box.

This icon to the left of bold italicized text denotes a note, which ale
you to important information.

This icon to the left of bold italicized text denotes a caution, which 
advises you of precautions to take to avoid injury, data loss, or a 
system crash.

bold Bold text denotes the names of menus, menu items, dialog boxes, di
box buttons or options, icons, or windows.

bold italic Bold italic text denotes a note or caution.

bold monospace Bold text in this font denotes the messages and responses that the
computer automatically prints to the screen.

IEEE 488 and IEEE 488 and IEEE 488.2 refer to the ANSI/IEEE Standard 488.1-1
IEEE 488.2 and the ANSI/IEEE Standard 488.2-1992, respectively, which defi

the GPIB.

italic Italic text denotes disk names, emphasis, a cross reference, or an 
introduction to a key concept. This font also denotes text from whic
you supply the appropriate word or value, as in Windows 3.x.

italic monospace Italic text in this font denotes that you must supply the appropriate 
words or values in the place of these items.

monospace Text in this font denotes text or characters that you should literally en
from the keyboard, sections of code, programming examples, and 
syntax examples. This font is also used for the proper names of dis
drives, paths, directories, programs, subprograms, subroutines, de
names, functions, operations, variables, filenames and extensions,
for statements and comments taken from programs.

!

© National Instruments Corporation xiii Plug and Play GPIB for Windows 98/95
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Related Documentation
The following documents contain information that you might find 
helpful as you read this manual:

• ANSI/IEEE Standard 488.1-1987, IEEE Standard Digital Interface 
for Programmable Instrumentation

• ANSI/IEEE Standard 488.2-1992, IEEE Standard Codes, Formats,
Protocols, and Common Commands

• LabVIEW Function and VI Overview Manual

• LabVIEW User Manual

• LabWindows/CVI Standard Libraries Reference Manual

• LabWindows/CVI User Manual

• Microsoft Windows Online Help, Microsoft Corporation

• PCI Card Standard, Release 2.1, Personal Computer Memory Card
International

• PCI Local Bus Specification, Revision 2.0, PCI Special Interest 
Group

• Plug and Play for PC-98 Bus Standard

• Plug and Play ISA Specification, Intel Corporation and Microsoft 
Corporation

Customer Communication
National Instruments wants to receive your comments on our produ
and manuals. We are interested in the applications you develop wi
our products, and we want to help if you have problems with them. 
To make it easy for you to contact us, this manual contains comme
and configuration forms for you to complete. These forms are in 
Appendix E, Customer Communication, at the end of this manual.
Plug and Play GPIB for Windows 98/95 xiv © National Instruments Corporation



© National Instruments Corporation 1-1 Plug and P
Chapter

1
Introduction
 get 
and 
This chapter explains how to use this manual, lists what you need to
started, provides an overview of the Plug and Play GPIB hardware 
software, and describes optional equipment you can order.

How to Use This Manual
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What You Need to Get Started
Make sure you have all of the following items before you attempt to
install the hardware and software:

❑ Windows 95 or later installed on your computer

❑ One of the following Plug and Play GPIB interfaces:

AT-GPIB/TNT (PnP)
PCI-GPIB
PCMCIA-GPIB
NEC-GPIB/TNT (PnP)

❑ GPIB Software for Windows NT/98/95 CD, which comes in your kit

❑ GPIB cables—single-shielded or double-shielded, Type X1, X2, X
X5, or X11, which you can order from National Instruments

Note: If you do not have a CD drive and would like to order the GPIB software
on floppy disks, contact National Instruments and order part number 
777780-01.

Optional Equipment
Call National Instruments for more information about the following 
optional equipment:

• Serial or parallel bus extender and cables
• Bus expander/isolator
• GPIB mechanical switch

Plug and Play GPIB Hardware Overview
The Plug and Play GPIB hardware is completely software-configurab
The AT-GPIB/TNT (PnP) complies with the Plug and Play ISA 
standard; the NEC-GPIB/TNT (PnP) complies with the Plug and Pla
for PC-98 Bus standard; the PCI-GPIB complies with the PCI Local B
Specification; and the PCMCIA-GPIB complies with the PC Card 
standard.

The Plug and Play GPIB hardware transforms your computer into a
fully functioning GPIB Talker/Listener/Controller. The TNT4882C 
chip on each Plug and Play GPIB board combines the circuitry of th
Plug and Play GPIB for Windows 98/95 1-2 © National Instruments Corporation



Chapter 1 Introduction

te 
s 
a 
 the 
fer 

 

al 

 is 

The 
ts 

f 
ces 
the 

 
trol 

th 
IB 
NAT4882 ASIC, the Turbo488 ASIC, and GPIB transceivers to crea
a single-chip IEEE 488.2 interface. The TNT4882C also implement
the HS488 high-speed protocol, which increases the maximum dat
transfer rate to up to 7.8 Mbytes/s, depending on the computer and
system configuration. For more information about transfer rates, re
to Appendix D, Specifications, in this manual. For more information 
about HS488, refer to Chapter 7, GPIB Programming Techniques, in the 
GPIB User Manual for Win32.

The AT-GPIB/TNT (PnP), NEC-GPIB/TNT (PnP), PCI-GPIB, and 
PCMCIA-GPIB each contain one GPIB load; you can connect up to
14 instruments to one of these interfaces. If you want to use more 
instruments, you can order a bus extender or expander from Nation
Instruments. Refer to Appendix D, Specifications, for more information 
about the hardware specifications and recommended operating 
conditions.

GPIB Software Overview
The GPIB software includes a native, 32-bit multitasking driver that
fully Plug and Play aware. The driver components are dynamically 
loaded when Windows detects new Plug and Play GPIB hardware. 
driver components are dynamically unloaded when Windows detec
the removal of Plug and Play GPIB hardware.

The GPIB software supports the concurrent use of multiple types o
GPIB hardware. For example, you can communicate with GPIB devi
through both a PCI-GPIB and PCMCIA-GPIB in the same system at 
same time. The GPIB software is fully integrated into the Windows 
operating system. It is configurable through the System applet and
uninstallable through the Add/Remove Programs applet of the Con
Panel.

The GPIB software, along with the Plug and Play GPIB hardware, 
transforms your computer into a GPIB Talker/Listener/Controller wi
complete communications and bus management capability. The GP
software includes the following components:

• Device driver

• Diagnostic test utility

• Configuration utility

• Interactive control program
© National Instruments Corporation 1-3 Plug and Play GPIB for Windows 98/95
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• Utilities for software development

• Language interface libraries for Microsoft Visual C/C++ 2.0 or 
later, Borland C/C++ 4.0 or later, and Microsoft Visual Basic 4.
or later

• Sample applications that use NI-488 functions and NI-488.2 
routines

Refer to Appendix D, Specifications, for information about the GPIB 
software transfer rates.

Time-Saving Development Tools
Your kit includes the GPIB software. In addition, you can order the 
LabWindows/CVI or LabVIEW software from National Instruments t
speed your application development time and make it easier to 
communicate with your instruments. 

LabVIEW is an easy-to-use, graphical programming environment y
can use to acquire data from thousands of different instruments, 
including IEEE 488.2 devices, VXI devices, serial devices, PLCs, a
plug-in data acquisition boards. After you have acquired raw data, y
can convert it into meaningful results using the powerful data analy
routines in LabVIEW. LabVIEW also comes with hundreds of 
instrument drivers, which dramatically reduce software developmen
time, because you do not have to spend time programming the low-le
control of each instrument.

LabWindows/CVI is similar to LabVIEW, except that it combines an
interactive, easy-to-use development approach with the programmi
power and flexibility of compiled ANSI C code.

The GPIB Analyzer is another optional tool available from National
Instruments that is useful in troubleshooting a variety of IEEE 488 
hardware and software problems. With its built-in time-stamping 
capability, you can easily determine the throughput and overhead o
your GPIB systems. The GPIB Analyzer can be used with the 
AT-GPIB/TNT+ and PCMCIA-GPIB+ GPIB hardware, which provide
GPIB Analyzer support along with the functionality of a 
high-performance GPIB Controller.

For ordering information, or to request free demonstration software
contact National Instruments.
Plug and Play GPIB for Windows 98/95 1-4 © National Instruments Corporation
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This chapter describes how to install and configure the Plug and P
GPIB hardware and software.

Install the Plug and Play GPIB Software
Complete the following steps to install the GPIB software:

1. Insert the CD GPIB Software for Windows NT/98/95. The CD 
autoplay feature automatically launches the setup wizard.

The setup wizard guides you through the necessary steps to in
the GPIB software. You can go back and change values where
appropriate by clicking on the Back button. You can exit the setup
if necessary by clicking on the Cancel button.

Note: If you do not have a CD drive and would like to order the GPIB software
on floppy disks, contact National Instruments and order part number 
777780-01.

2. When the setup is complete, restart Windows.

Install the AT-GPIB/TNT(PnP) or PCI-GPIB Hardware

Caution: Electrostatic discharge can damage several components on these GPIB
boards. To avoid such damage in handling your board, touch the antistat
plastic package to a metal part of your computer chassis before removin
the board from the package.

1. Make sure that your computer is turned off. Keep the computer
plugged in so that it remains grounded while you install the GP
hardware.

2. Remove the top cover (or other access panels) to give yourself
access to the computer expansion slots.

!
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3. Find an unused expansion slot in your computer. The 
AT-GPIB/TNT (PnP) board requires a 16-bit ISA expansion slo
The PCI-GPIB requires a PCI slot.

4. Remove the corresponding slot cover on the back panel of the 
computer.

5. Insert the GPIB board into the slot with the GPIB connector 
sticking out of the opening on the back panel, as shown in 
Figure 2-1. It might be a tight fit, but do not force the board into
place. 

Figure 2-1.  Installing the AT-GPIB/TNT (PnP)

6. Screw the mounting bracket of the GPIB board to the back pan
rail of the computer.

7. Replace the top cover (or the access panel to the expansion sl

8. Turn on your computer and start Windows. Windows should 
automatically detect the GPIB hardware and briefly display a 
New Hardware Found dialog box.
Plug and Play GPIB for Windows 98/95 2-2 © National Instruments Corporation
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If the New Hardware Found dialog box does not appear when you
restart Windows, refer to Appendix B, Forcing Windows to Detect 
the GPIB Hardware.

The GPIB hardware installation is now complete. Proceed to the 
Configure the GPIB Software section later in this chapter.

Install the PCMCIA-GPIB Hardware
To install the PCMCIA-GPIB in your computer, first start Windows. I
the card is not already inserted, insert it into a free PC Card (PCMC
socket the same way you insert a disk into a floppy drive. The card 
no jumpers or switches to set, and you do not need to power down
system when you insert it. Figure 2-2 shows how to insert the 
PCMCIA-GPIB and how to connect the cable.

Figure 2-2.  Inserting the PCMCIA-GPIB

Windows automatically displays one or more New Hardware Found 
dialog boxes when it detects and configures a PC Card. A single New 
Hardware Found dialog box appears when you insert the card.

PCMCIA-GPIB
Cable

PCMCIA
Socket

Portable
Computer

INSERT CARD
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If no New Hardware Found dialog box appears when you insert your
PC Card, make sure that 32-bit PCMCIA drivers are enabled. In the
System Properties dialog box under Start»Settings»Control 
Panel»System, select the Performance tab and look at the PC Cards 
(PCMCIA):  line. If it reads 32-bit , the 32-bit PCMCIA drivers are 
enabled. In this case, follow the instructions in Appendix B, Forcing 
Windows to Detect the GPIB Hardware. Otherwise, enable 32-bit 
PCMCIA drivers by running the PC Card (PCMCIA) Wizard , a control 
panel applet found under Start»Settings»Control Panel»PC Card 
(PCMCIA) . After enabling 32-bit PCMCIA drivers, you need to shut
down your computer and restart it. When your computer restarts, y
PCMCIA-GPIB is detected, if it has been inserted, and the New 
Hardware Found dialog boxes appear. If a New Hardware Found 
dialog box still does not appear, refer to Appendix B, Forcing Windows 
to Detect the GPIB Hardware.

The hardware installation is now complete. Proceed to the Configure 
the GPIB Software section later in this chapter.

Install the NEC-GPIB/TNT (PnP) Hardware
Complete the following steps to install the NEC-GPIB/TNT (PnP):

1. Make sure that your computer is turned off. Keep the computer
plugged in so that it remains grounded while you install the GP
hardware.

2. Find an unused expansion slot in your computer.

3. Remove the corresponding slot cover on the back panel of the 
computer.

4. Insert the NEC-GPIB/TNT (PnP) into the slot. It might be a tigh
fit, but do not force the board into place.

5. Screw the mounting bracket of the NEC-GPIB/TNT (PnP) to the
back panel of the computer.

6. Turn on your computer and start Windows. Windows should 
automatically detect the GPIB hardware and briefly display a 
New Hardware Found dialog box.

The NEC-GPIB/TNT hardware installation is now complete. Proceed
the next section, Configure the GPIB Software.
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Configure the GPIB Software
The GPIB Configuration utility is fully integrated with the Windows 
Device Manager. You can use it to examine or modify the configurat
of the GPIB software. The context-sensitive online help, available b
right-clicking on any of the controls on the configuration utility tabs,
includes all of the information that you need to configure the GPIB 
software properly.

To begin to configure the GPIB software, double-click on the System 
icon under Start»Settings»Control Panel. In the System Properties 
dialog box that appears, select the Device Manager tab, click on the 
View devices by type button at the top of the tab, and scroll down to th
National Instruments GPIB Interfaces icon.

Resolve Conflicts
If you have other non Plug and Play hardware in your system, Windo
might assign incorrect resources to your AT-GPIB/TNT (PnP). If thi
happens, Windows shows that the board is not working, and you m
reconfigure the AT-GPIB/TNT (PnP) interface and the GPIB softwa

On the Device Manager page, look at the items listed under the 
National Instruments GPIB Interfaces icon. If there is no 
National Instruments GPIB Interfaces icon or if a circled X or 
exclamation point (!) appears through the eagle icon, the 
AT-GPIB/TNT (PnP) is not working properly. Figure 2-3 shows an 
example of a AT-GPIB/TNT (PnP) that is working properly, and 
Figure 2-4 shows an example of a AT-GPIB/TNT (PnP) that is not 
working properly.

Figure 2-3.  GPIB Interface That Is Working Properly
© National Instruments Corporation 2-5 Plug and Play GPIB for Windows 98/95
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Figure 2-4.  GPIB Interface That Is Not Working Properly

You can see if the problem is a resource conflict by looking at wha
resources are conflicting, if the AT-GPIB/TNT (PnP) appears under the
National Instruments GPIB Interfaces icon. Double-click on the 
AT-GPIB/TNT (PnP) name and click on the Resources tab, which 
provides information about the hardware resources assigned to the
AT-GPIB/TNT (PnP). The Conflicting Device List lists any conflicts. If 
conflicts exist, use the Setting based on drop-down list and the 
Change Setting button to select conflict-free resources for the 
AT-GPIB/TNT (PnP).

If you cannot find conflict-free resources for the AT-GPIB/TNT (PnP), 
or if no conflicts are listed, refer to the Troubleshooting Device 
Manager Problems section of Appendix C, Troubleshooting and 
Common Questions, to resolve the problem.

Assign an Interface Name
If you are using more than one interface, you must configure the GP
software to associate a logical name (GPIB0, GPIB1, and so on) with 
each physical GPIB interface. Follow these steps:

1. Double-click on the first interface listed immediately below 
National Instruments GPIB Interfaces.

2. Click on the GPIB Settings tab, which provides information about
the software configuration for the AT-GPIB/TNT (PnP).

3. Use the Interface Name drop-down box to select a logical name 
(GPIB0, GPIB1, and so on) for the AT-GPIB/TNT (PnP).

4. Repeat this process for each interface you need to configure.
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Figure 2-5 shows the GPIB Settings page for an AT-GPIB/TNT (PnP).

Figure 2-5.  GPIB Settings Page for the AT-GPIB/TNT (PnP)

View or Modify Logical Device Templates (Optional)
If you want to examine or modify the logical device templates for th
GPIB software, select the National Instruments GPIB Interfaces icon 
from the Device Manager page, and click on the Properties button. 
Select the Device Templates tab to view the logical device templates,
as shown in Figure 2-6.
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Figure 2-6.  Device Templates Page for the Logical Device Templates
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This chapter describes how to verify the hardware and software 
installation.

You can use the Diagnostic utility, installed with your GPIB softwar
to test the hardware and software installation. The utility verifies th
your hardware and software are functioning properly and that the 
configuration of your GPIB interfaces does not conflict with anythin
else in your system.

To run the utility, select the Diagnostic item under Start»Programs» 
National Instruments GPIB.

When you have started the Diagnostic utility, test your GPIB interfac
by clicking on the Test All button. If the Diagnostic is successful, it put
a checkmark next to the interface and changes its status from untested 
to passed. If the Diagnostic fails, it puts an X next to the interface, an
changes its status from untested to failed. Figure 3-1 shows the 
Diagnostic utility after it has tested some GPIB interfaces.

Figure 3-1.  Diagnostic Utility after Testing
lay GPIB for Windows 98/95
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You can get details on any tested GPIB interface by selecting the 
interface and clicking on the Details button. For each failed GPIB 
interface, select it and click on the Details button to get a description of
the failure. Use that information and the information in Appendix C, 
Troubleshooting and Common Questions, to troubleshoot the problem.
Troubleshooting information is also available in the online help for t
Diagnostic utility, which you can access by clicking on the Help button.
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This chapter helps you get started with the GPIB software.

Getting Started with LabVIEW
LabVIEW is a fully-functional graphical programming environment use
to develop measurement and automation applications. LabVIEW featu
comprehensive libraries for instrument control, data analysis, and data
presentation. If you already installed LabVIEW, you can use the LabVIE
GPIB functions without any additional installation. To learn about the ba
concepts of GPIB communication, refer to the LabVIEW GPIB function
chapter in the LabVIEW User Manual. To learn more about each GPIB 
function, refer to the LabVIEW Function and VI Overview Manual and the 
online help.

National Instruments provides LabVIEW instrument drivers to simplify
application development. Instrument drivers are high-level functions th
eliminate the need to learn the complex, low-level programming comma
for each instrument.   For more information, refer to Chapter 7, Getting 
Started with a LabVIEW Instrument Driver, in the LabVIEW User Manual. 
If you want to write your own instrument driver, National Instruments 
provides application notes that help you get started.

To use instrument drivers in LabVIEW, select the Instrument Wizard  
from the Project menu.

For more information about National Instruments products, refer to ou
web site at http://www.natinst.com/products/ .

Getting Started with LabWindows/CVI
LabWindows/CVI is an interactive C development environment used 
to build measurement and automation applications. It provides 
comprehensive libraries for instrument control, data analysis, and data
presentation. If you already installed LabWindows/CVI, you can use th
LabWindows/CVI GPIB Library without any additional installation. The
lay GPIB for Windows 98/95
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LabWindows/CVI GPIB Library includes the functions documented in 
your NI-488.2 or NI-488.2M reference manual, as well as several 
additional functions, which are documented in the GPIB library chapter
the LabWindows/CVI Standard Libraries Reference Manual. To help you 
use the GPIB functions, LabWindows/CVI provides function panels for t
GPIB Library. To access the function panels, select GPIB/GPIB 488.2 
from the Library  menu of the Project or Source windows. For 
information about using function panels, refer to the function panels 
chapter in the LabWindows/CVI User Manual.

If you need to program a GPIB instrument, you might want to use an 
instrument driver. An instrument driver is a set of high-level C functions 
controlling a specific instrument. The low-level steps to control the 
instrument and read data are encapsulated in the high-level functions.
can write an instrument driver yourself, or you can use one that is alre
written. When you purchase LabWindows/CVI, you get free access to 
library of drivers for hundreds of instruments. For more information abo
instrument drivers, refer to the project window chapter in the 
LabWindows/CVI User Manual.

For more information about National Instruments products, please refe
our web site at http://www.natinst.com/products/ .

Introduction to the Win32 Interactive Control Utility
You can use the interactive control utility to enter NI-488 functions a
NI-488.2 routines interactively and see the values returned by the 
function calls. You can use the utility to do the following:

• Verify GPIB communication with your device.

• Learn the NI-488 functions and NI-488.2 routines before you wr
your application.

• Become familiar with the commands of your device.

• Receive data from your GPIB device.

• Troubleshoot problems with your application.

To run this utility, select the Win32 Interactive Control  item under 
Start»Programs»National Instruments GPIB. This utility includes 
extensive online help, available by entering help  at the: prompt.

For more information about the Win32 Interactive Control utility, refe
to the GPIB User Manual for Win32.
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Introduction to the NI Spy Utility
Included with the GPIB software is NI Spy, a Win32 utility that can b
used to monitor NI-488.2 calls made by Win32, Win16, and DOS GP
applications. You can use NI Spy to do the following:

• Capture information about NI-488 functions and NI-488.2 routin
as they are invoked by your GPIB applications.

• Display captured information, including, but not limited to, inpu
and output parameter values, I/O buffer contents, and return val

• Save, restore, and print captured information.

To run NI Spy, select the NI Spy item under Start»Programs»National 
Instruments GPIB. For more information about the NI Spy utility, refe
to Chapter 5, NI Spy Utility, in the GPIB User Manual for Win32, or use 
its built-in, context-sensitive online help.

Running Existing DOS GPIB Applications
With the GPIB software properly configured, you can run your existi
DOS GPIB applications along with your Win16 and Win32 
applications. No DOS device driver is required. In fact, you should 
make sure that no older version of the GPIB DOS device driver is be
loaded from your config.sys  file, a file located on the boot drive of 
your computer.

Note: To determine if config.sys  is loading an older GPIB DOS driver, look for 
the line device= path \gpib.com  in your config.sys  file, where path  
refers to the drive and directory where gpib.com  is located. If that line 
appears, either comment it out by typing REM at the beginning of the line, 
or delete it. If you change the config.sys  file, save it and restart your 
system.

To configure the GPIB software to run existing DOS GPIB 
applications, first make sure that you have installed the GPIB softw
and your GPIB hardware. Then complete the following steps:

1. Double-click on the System icon under Start»Settings»Control 
Panel. 

2. In the System Properties dialog box that appears, select the Device 
Manager tab.

3. Click on the View devices by type button at the top of the page.
© National Instruments Corporation 4-3 Plug and Play GPIB for Windows 98/95
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4. Click on the National Instruments GPIB Interfaces icon.

5. Click on the Properties button to display the General property page 
for the GPIB software.

6. Select the check box labeled Enable Support for DOS GPIB 
Applications, and click on the OK  button.

7. Restart your computer.

After you restart your computer, you can begin to run your existing 
DOS GPIB applications.

For more information about running existing DOS GPIB application
with the GPIB software for Windows, refer to the GPIB User Manual for 
Win32.

General Programming Considerations
As you begin developing your Win32 GPIB application, remember t
following points:

• For your C/C++ application, you must include the GPIB header f
in your source code.

• The GPIB software is accessed through the 32-bit DLL, 
gpib-32.dll , either by linking with one of the language interface
provided with the GPIB software, or by using direct DLL entry 
from other programming environments.

• Several sample GPIB applications are included with the GPIB 
software. Use these as a guide for your own application 
development.

For information about choosing a programming method, developing
your application, or compiling and linking, refer to the GPIB User 
Manual for Win32. For detailed information about each NI-488 functio
and NI-488.2 routine, refer to the NI-488.2M Function Reference Manua
for Win32 or the online help file, which you can access by selecting 
Start»Programs»National Instruments GPIB»GPIB32 Help.
Plug and Play GPIB for Windows 98/95 4-4 © National Instruments Corporation
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This appendix describes how to uninstall your Plug and Play GPIB 
hardware and software.

Uninstalling the Plug and Play GPIB Hardware
Before you physically remove the GPIB hardware from your system
you must remove the hardware information from the Windows Devi
Manager. Complete the following steps to remove the hardware 
information:

1. Select Start»Settings»Control Panel and double-click on the 
System icon.

2. In the System Properties dialog box, select the Device Manager 
tab, click on the View devices by type button, and double-click on 
the National Instruments GPIB Interfaces icon.

3. Select the interface you want to remove from the National 
Instruments GPIB Interfaces list, as shown in Figure A-1. Click 
on the Remove button to remove the hardware information.

4. If your interface is an AT-GPIB/TNT (PnP), NEC-GPIB/TNT 
(PnP), or PCI-GPIB, click on the OK  button, shut down Windows, 
turn off your system, and physically remove the interface from yo
system. 

If your interface is a PCMCIA-GPIB, you may eject it after you 
have removed the hardware information from the Device Manag
Play GPIB for Windows 98/95
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Figure A-1.  Selecting an Interface to Remove

Uninstalling the GPIB Software
Before you uninstall the GPIB software, you should remove all GPI
hardware information from the Windows Device Manager, as describ
in the previous section. Complete the following steps to uninstall th
GPIB software:

1. Select Start»Settings»Control Panel and double-click on the 
Add/Remove Programs icon. The dialog box shown in Figure A-2
lists the software available for removal.
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Figure A-2.  Add/Remove Programs Properties Dialog Box

2. Select the GPIB software you want to remove and click on the 
Add/Remove button. The uninstall program removes all folders, 
programs, VxDs, DLLs, and registry entries associated with the
GPIB software.

If you have interfaces other than PC Cards (PCMCIA-GPIB) and yo
have not physically removed them from your computer, shut down 
Windows, turn off your system, and remove the interfaces now. 

The uninstall program removes only items that the GPIB setup progr
installed. If you add anything to a directory that was created by the
GPIB setup program, the uninstall program does not delete that 
directory, because the directory is not empty after the uninstallation
You will need to remove any remaining components yourself.

If you want to reinstall the hardware and software, refer to Chapter 2, 
Installation and Configuration.
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This appendix contains instructions to help you install your GPIB 
interface if Windows has not detected it properly.

If Windows does not detect your interface properly, it may not displ
the New Hardware Found dialog boxes when expected, or the driver
may return an EDVR error when you try to access the GPIB interfa
This problem occurs if Windows has already configured the GPIB 
interface as an Other Device. To fix the problem, complete the 
following steps:

1. Select Start»Settings»Control Panel.

2. Double-click on the System icon to display the System Properties 
dialog box for the computer.

3. Select the Device Manager tab at the top of the System Properties 
page to bring up the Device Manager property page. Make sure the
View devices by type button at the top of the Device Manager page 
is selected.

4. Click on the + sign next to Other Devices to display a list of all the 
hardware devices that Windows has detected and configured a
Other Devices.

5. For each National Instruments GPIB interface listed, select the
interface by clicking on it, and then click on the Remove button to 
remove the interface from the list of Other Devices.

6. After you have removed all of the National Instruments GPIB 
interfaces from the list of Other Devices, click on the Refresh 
button to force Windows to detect each National Instruments GP
interface and to display a New Hardware Found dialog box for 
each one.

7. Proceed with the hardware installation, as described in Chapter 2, 
Installation and Configuration.
Play GPIB for Windows 98/95
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This appendix describes how to troubleshoot problems and answer
some common questions.

Troubleshooting EDVR Error Conditions
In some cases, calls to NI-488 functions or NI-488.2 routines may 
return with the ERR bit set in ibsta  and the value EDVR in iberr . The 
value stored in ibcntl  is useful in troubleshooting the error condition

EDVR Error Condition with ibcntl Set to 0xE028002C (-534249428)
If a call is made with a board number that is within the range of allow
board numbers (typically 0 to 3), but which has not been assigned 
GPIB interface, an EDVR error condition occurs with ibcntl  set to 
0xE028002C. You can assign a board number to a GPIB interface 
configuring the GPIB software and selecting an interface name. Fo
information on how to configure the GPIB software, refer to Configure 
the GPIB Software in Chapter 2, Installation and Configuration.

EDVR Error Condition with ibcntl Set to 0xE0140025 (-535560155)
If a call is made with a board number that is not within the range of
allowed board numbers (typically 0 to 3), an EDVR error condition 
occurs with ibcntl  set to 0xE0140025. 

EDVR Error Condition with ibcntl Set to 0xE0140035 (-535560139)
If a call is made with a device name that is not listed in the logical 
device templates that are part of the GPIB Configuration utility, an 
EDVR error condition occurs with ibcntl  set to 0xE0140035. 

EDVR Error Condition with ibcntl Set to 0xE0320029 (-533594071) or 
0xE1050029 (-519765975)

If a call is made with a board number that is assigned to a GPIB 
interface that is unusable because of a resource conflict, an EDVR e
Play GPIB for Windows 98/95
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condition occurs with ibcntl  set to 0xE0320029 or 0xE1050029. Thi
error condition indicates that the GPIB interface is not working 
properly. Refer to the GPIB Interface Not Working Properly section 
later in this appendix. This error is also returned if you remove a 
PCMCIA-GPIB while the driver is accessing it, or if you try to access
PCMCIA-GPIB and 32-bit drivers are not enabled. For information 
about enabling 32-bit PCMCIA drivers, refer to the Install the 
PCMCIA-GPIB Hardware section of Chapter 2, Installation and 
Configuration.

EDVR Error Condition with ibcntl set to 0xE0140004 (-535560188)
This error may occur if the GPIB interface has not been correctly 
installed and detected by Windows. For details on how to install the
GPIB hardware, refer to Chapter 2, Installation and Configuration.  
If you have already followed those instructions and still receive this
error, Windows might have configured the GPIB interface as an Other 
Device. For information about how to solve this problem, refer to 
Appendix B, Forcing Windows to Detect the GPIB Hardware.

EDVR Error Condition with ibcntl set to 0xE1030043 (-519897021)
This error occurs if you have enabled DOS GPIB support and attemp
to run an existing GPIB DOS application that was compiled with an
older, unsupported DOS language interface.

Troubleshooting Device Manager Problems
The Windows Device Manager contains configuration information f
all of the GPIB hardware it is aware of that is installed in your syste
To start the Windows Device Manager, double-click on the System icon 
under Start»Settings»Control Panel. In the System Properties box that 
appears, select the Device Manager tab and click on the View devices 
by type button at the top of the tab.

• If there is no National Instruments GPIB Interfaces item and you 
are certain you have a GPIB interface installed, refer to the No 
National Instruments GPIB Interfaces Item section of this 
appendix.

• If the National Instruments GPIB Interfaces item exists, but the 
GPIB interface you are looking for is not listed there, refer to th
Missing GPIB Interface section of this appendix.
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• If the GPIB interface you are looking for is listed, but has a circle
X or exclamation mark (!) over its icon, refer to the GPIB Interface 
Not Working Properly section of this appendix.

No National Instruments GPIB Interfaces Item
If you are certain you have a Plug and Play GPIB interface installed,
no National Instruments GPIB Interfaces item appears in the Device 
Manager, the interface is probably incorrectly listed under Other 
Devices. Double-click on the Other Devices item in the Device Manager 
and, one by one, remove each National Instruments GPIB interface
listed there by selecting its name and then clicking on the Remove 
button. After all of the National Instruments GPIB interfaces have be
removed from Other Devices, click on the Refresh button. At this point, 
the system rescans the installed hardware, and the GPIB interface
should show up under National Instruments GPIB Interfaces without 
any problems. If the problem persists, contact National Instruments

Missing GPIB Interface
If the National Instruments GPIB Interfaces item exists, but the GPIB 
interface you are looking for is not listed there, the GPIB interface is 
properly installed. For Plug and Play GPIB hardware, this means th
interface is not physically present in the system.

GPIB Interface Not Working Properly
If a GPIB interface is not working properly, its icon has a circled X 
exclamation mark (!) overlaid on it, as shown in Figure C-1.

Figure C-1.  GPIB Interface That Is Not Working Properly

This problem can occur for several reasons. If you encounter this 
problem, the Device Manager should list an error code that indicate
why the problem occurred. To see the error code for a particular 
interface, select the name of the interface and click on the Properties 
button to go to the General page for that GPIB interface. The Device 
© National Instruments Corporation C-3 Plug and Play GPIB for Windows 98/95
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Status section of the General page shows the error code. Locate the 
error code in the following list to find out why your GPIB interface is
not working properly.

• Code 8: The GPIB software was incompletely installed. To solv
this problem, reinstall the GPIB software.

• Code 9: Windows had a problem reading information from the 
GPIB interface. This problem can occur if you are using an olde
revision of the AT-GPIB/TNT (PnP) interface. Contact National 
Instruments to upgrade your GPIB interface.

• Code 22: The GPIB interface is disabled. To enable the GPIB 
interface, check the appropriate configuration checkbox in the 
Device Usage section of the General page.

• Code 24: The GPIB interface is not present, or the Device Mana
is unaware that the GPIB interface is present. To solve this 
problem, select the interface in the Device Manager, and click 
the Remove button. Next, click on the Refresh button. At this point, 
the system rescans the installed hardware, and the GPIB interf
should show up without any problems. If the problem persists, 
contact National Instruments.

• Code 27: Windows was unable to assign the GPIB interface an
resources. To solve this problem, free up system resources by 
disabling other unnecessary hardware so that enough resource
available for the GPIB interface.

Troubleshooting Diagnostic Utility Failures
The following sections explain common error messages generated
the Diagnostic utility.

Missing Software Components
This error occurs if the software components that are necessary for
GPIB software to function correctly are not present in the system. If y
encounter this problem, reinstall the GPIB software and run the 
Diagnostic utility again.

No Properly Configured GPIB Interfaces Found
This error occurs if no GPIB interfaces are physically present in the
system, if the Device Manager detected problems with the GPIB 
interfaces, or if you have not assigned logical board names to your
Plug and Play GPIB for Windows 98/95 C-4 © National Instruments Corporation
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GPIB interfaces using the Device Manager. If you encounter this 
problem, use the Device Manager to examine the installed GPIB 
interfaces, resolve any problems reported by the Device Manager, 
ensure that logical board names are assigned to each interface. Th
run the Diagnostic utility again.

To access this information in the Device Manager, complete the 
following steps:

1. Double-click on the System icon under Start»Settings» 
Control Panel. 

2. In the System Properties dialog box that appears, select the 
DeviceManager tab.

3. Click on the View devices by type button at the top of the 
Device Manager page.

4. Double-click on the National Instruments GPIB Interfaces icon. 
If there is no National Instruments GPIB Interfaces icon, either no 
GPIB interfaces are installed in your system or the GPIB softwa
is installed incorrectly. If you see a National Instruments GPIB 
Interfaces icon, and a GPIB interface listed under it has a circled
or (!) over its icon, refer to the Troubleshooting Device Manager 
Problems section in this appendix.

5. After you have opened the National Instruments GPIB Interfaces 
icon, double-click on the GPIB interface name and select the GPIB 
Settings tab to examine the logical board name associated with t
interface. If it is set to None, change it to the appropriate name, 
such as GPIB0.

GPIB Cables Need to Be Disconnected
This error occurs if you have any GPIB cables connected to the GP
interface. Disconnect all GPIB cables and run the Diagnostic utility
again.

Address Resource Conflict
This error occurs if the address resources assigned to a GPIB inter
conflict with the address resources being used by other devices in 
system. Resource conflicts typically occur when your system conta
legacy boards that use resources that have not been reserved prop
with the Device Manager. If a resource conflict exists, write down th
resource that caused the conflict and refer to the Microsoft Window
Online Help for instructions on how to use the Device Manager to 
© National Instruments Corporation C-5 Plug and Play GPIB for Windows 98/95
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reserve I/O resources for legacy boards. After the conflict has been
resolved, run the Diagnostic utility again.

Interrupt Resource Conflict
This error occurs if the interrupt resources assigned to a GPIB interf
conflict with the interrupt resources being used by other devices in 
system. Resource conflicts typically occur when your system conta
legacy boards that use resources that have not been reserved prop
with the Device Manager. If a resource conflict exists, write down th
resource that caused the conflict and refer to the Microsoft Window
Online Help for instructions on how to use the Device Manager to 
reserve IRQ resources for legacy boards. After the conflict has bee
resolved, run the Diagnostic utility again.

DMA Resource Conflict
This error occurs if the DMA resources assigned to a GPIB interfac
conflict with the DMA resources being used by other devices in the
system. Resource conflicts typically occur when your system conta
legacy boards that use resources that have not been reserved prop
with the Device Manager. If a resource conflict exists, write down th
resource that caused the conflict and refer to the Microsoft Window
Online Help for instructions on how to use the Device Manager to 
reserve DMA resources for legacy boards. After the conflict has be
resolved, run the Diagnostic utility again.

Single-Cycle DMA Required
This error occurs if the Diagnostic utility detects that it is unable to 
perform demand-mode DMA for the GPIB interface and that the GP
software has not been configured to use single-cycle DMA. GPIB 
interfaces that use the system DMA controller, such as the 
AT-GPIB/TNT (PnP), normally use demand-mode DMA. If you get th
error, you should use the Device Manager to configure the GPIB 
software to use single-cycle DMA for all DMA transfers, and then ru
the Diagnostic utility again.
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To configure the GPIB software to use single-cycle DMA for a 
particular GPIB interface, complete the following steps:

1. Double-click on the System icon under Start»Settings» 
Control Panel. 

2. In the System Properties dialog box that appears, select the 
DeviceManager tab.

3. Click on the View devices by type button at the top of the 
DeviceManager page.

4. Double-click on the National Instruments GPIB Interfaces icon.

5. Double-click on the GPIB interface to be configured.

6. Select the GPIB Settings tab.

7. Click on the Advanced button and make sure that the Demand 
Mode DMA  item is unchecked.

GPIB Software Problem Encountered
This error occurs if the Diagnostic utility detects that it is unable to 
communicate correctly with the GPIB hardware using the installed 
GPIB software. If you get this error, shut down your computer, rest
it, and run the Diagnostic utility again. If the problem persists, try 
reinstalling the GPIB software.

Unknown Problem Encountered
This error occurs if an unknown problem is encountered while trying
execute the Diagnostic utility. If you encounter this problem, shut do
your computer, restart it, and run the Diagnostic utility again. If the 
problem persists, try reinstalling the GPIB software.

Common Questions
What do I do if my GPIB hardware is listed in the Windows Device 
Manager with a circled X or exclamation point (!) overlaid on it?

Refer to the GPIB Interface Not Working Properly section of this 
appendix for specific information about what might cause this proble
If you have already completed the troubleshooting steps, fill out the
forms in Appendix E, Customer Communication, and contact National 
Instruments. 
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How can I determine which type of GPIB hardware I have 
installed?

Run the GPIB Configuration utility: select Start»Settings»Control 
Panel and double-click on the System icon. Select the Device Manager 
tab in the System Properties dialog box. Click on the View devices by 
type radio button at the top of the page. If any GPIB hardware is 
correctly installed, a National Instruments GPIB Interfaces icon 
appears in the list of device types. Double-click on this icon to see a
of installed GPIB hardware.

How can I determine which version of the GPIB software I have 
installed?

Run the Diagnostic utility: select the Diagnostic item under 
Start»Programs»National Instruments GPIB. The Diagnostic utility 
displays the version of the GPIB software that is installed in a banne
the bottom of the window that appears.

What do I do if the Diagnostic utility fails with an error?

Use the Diagnostic utility online help, or refer to the troubleshooting
sections earlier in this appendix. If you have already completed the
troubleshooting steps, fill out the forms in Appendix E, Customer 
Communication, and contact National Instruments.

How many GPIB interfaces can I configure for use with my GPIB 
software? 

You can configure the GPIB software to communicate with up to 10
GPIB interfaces. 

How many devices can I configure for use with my GPIB software? 

The GPIB software provides a total of 1,024 logical devices for 
applications to use. The default number of devices is 32. The maxim
number of physical devices you should connect to a single GPIB 
interface is 14, or fewer, depending on your system configuration.

Are interrupts and DMA required for the GPIB software?

Neither interrupts nor DMA are required, unless you are using the 
PCMCIA-GPIB, which requires an interrupt level.
Plug and Play GPIB for Windows 98/95 C-8 © National Instruments Corporation
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How can I determine if my GPIB hardware and software are 
installed properly?

Run the Diagnostic utility: select the Diagnostic item under Start» 
Programs»National Instruments GPIB. Refer to the Troubleshooting 
Diagnostic Utility Failures section in this appendix or the online help
to troubleshoot any problems.

When should I use the Win32 Interactive Control utility?

You can use the Win32 Interactive Control utility to test and verify 
instrument communication, troubleshoot problems, and develop yo
application program. For more information, refer to the Getting Started 
with LabVIEW section in Chapter 4, Begin to Use the GPIB Software.

How do I use a GPIB language interface?

For information about using GPIB language interfaces, refer to 
Chapter 3, Developing Your Application, in the GPIB User Manual for 
Win32.

Why does the uninstall program leave some components installed?

The uninstall program removes only items that the GPIB setup progr
installed. If you add anything to a directory that was created by the
GPIB setup program, the uninstall program does not delete that 
directory, because the directory is not empty after the uninstallation
You need to remove any remaining components yourself.

I have already installed my GPIB software, and when I try to install 
my AT-GPIB/TNT (PnP), Windows does not recognize my new 
hardware, or it recognizes it but reports a problem. It reports an 
error code of 9 on the Device Manager General tab for the 
hardware. What should I do?

This problem may occur with early revisions of the AT-GPIB/TNT 
(PnP) boards. If you are experiencing this problem, contact Nationa
Instruments to upgrade your board.

What information should I have before I call National Instruments?

When you call National Instruments, you should have the results of 
Diagnostic utility test. Also, make sure you have filled out the forms
Appendix E, Customer Communication.
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This appendix describes the physical characteristics of the GPIB 
hardware, the transfer rates of the GPIB software, and the recommen
operating conditions.

Hardware Characteristics

Table D-1.  AT-GPIB/TNT (PnP) Hardware Characteristics

Characteristic Specification

Dimensions 10.67 cm by 16.51 cm
(4.2 in. by 6.5 in.) 

Power Requirement
(from PC AT I/O Channel)

+5 VDC 120 mA Typical
200 mA Maximum

I/O Connector IEEE 488 Standard 24-Pin

Operating Environment
Component Temperature
Relative Humidity

0° to 55° C
10% to 90%, Noncondensing

Storage Environment
Temperature
Relative Humidity

–20° to 70° C
5% to 90%, Noncondensing

EMI FCC Class B Certified
Play GPIB for Windows 98/95
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Table D-2.  NEC-GPIB/TNT (PnP) Hardware Characteristics

Characteristic Specification

Dimensions 14.87 cm by 16.92 cm
(5.85 in. by 6.66 in.) 

Power Requirement
(from PC-98 Bus)

+5 VDC 260 mA Typical
750 mA Maximum

I/O Connector IEEE 488 Standard 24-Pin

Operating Environment
Component Temperature
Relative Humidity

0° to 55° C
10% to 90%, Noncondensing

Storage Environment
Temperature
Relative Humidity

–20° to 70° C
5% to 90%, Noncondensing

EMI VCCI Certified
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Table D-3.  PCI-GPIB Hardware Characteristics

Characteristic Specification

Dimensions 13.34 cm by 10.67 cm
(5.25 in. by 4.2 in.) 

Power Requirement
(from PCI Bus)

+5 VDC 300 mA Typical
 450 mA Maximum

I/O Connector IEEE 488 Standard 24-Pin

Operating Environment
Ambient Temperature
Relative Humidity

0° to 55° C
10% to 90%, Noncondensing

Storage Environment
Temperature
Relative Humidity

–20° to 70° C
5% to 90%, Noncondensing

EMI FCC Class B Certified
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Table D-4.  PCMCIA-GPIB Hardware Characteristics

Characteristic Specification

Dimensions 85.6 mm by 54.0 mm by 5.0 mm
(3.370 in. by 2.126 in. by 0.197 in.)

Power Requirement
(from PCMCIA Expansion Slot)

+5 VDC 65 mA Typical
85 mA Maximum

I/O Interface Special IEEE 488 cable with 
24-Pin Converter for PC Card

Operating Environment
Component Temperature
Relative Humidity

0° to 55° C
10% to 90%, Noncondensing

Storage Environment
Temperature
Relative Humidity

–20° to 70° C
5% to 90%, Noncondensing

EMI FCC Class A Verified
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Software Transfer Rates
Table D-5.  GPIB Software Transfer Rates for the Plug and Play GPIB Hardware

GPIB Hardware Transfer Method
Maximum GPIB

Transfer Rate

AT-GPIB/TNT (PnP) 3-wire (IEEE 488)

High Speed (HS488)

1.5 Mbytes/s*

1.8 Mbytes/s*

NEC-GPIB/TNT 
(PnP)

3-Wire (IEEE 488)
High Speed (HS488)

1.0 Mbytes/s*
1.0 Mbytes/s*

PCI-GPIB 3-Wire (IEEE 488)
High Speed (HS488)

1.5 Mbytes/s*
7.8 Mbytes/s*

PCMCIA-GPIB 3-Wire (IEEE 488)
High Speed (HS488)

1.4 Mbytes/s*
1.7 Mbytes/s*

* Actual speed may vary considerably from speed shown because of system and 
instrumentation capabilities.
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For your convenience, this appendix contains forms to help you gather the information necessa
to help us solve your technical problems and a form you can use to comment on the product 
documentation. When you contact us, we need the information on the Technical Support Form
the configuration form, if your manual contains one, about your system configuration to answer
questions as quickly as possible.

National Instruments has technical assistance through electronic, fax, and telephone systems to
provide the information you need. Our electronic services include a bulletin board service, an FT
a fax-on-demand system, and e-mail support. If you have a hardware or software problem, first 
electronic support systems. If the information available on these systems does not answer you
questions, we offer fax and telephone support through our technical support centers, which are
by applications engineers. 

Electronic Services

Bulletin Board Support
National Instruments has BBS and FTP sites dedicated for 24-hour support with a collection of
and documents to answer most common customer questions. From these sites, you can also d
the latest instrument drivers, updates, and example programs. For recorded instructions on how
the bulletin board and FTP services and for BBS automated information, call 512 795 6990. Yo
access these services at:

United States: 512 794 5422
Up to 14,400 baud, 8 data bits, 1 stop bit, no parity

United Kingdom:  01635 551422
Up to 9,600 baud, 8 data bits, 1 stop bit, no parity

France:  01 48 65 15 59
Up to 9,600 baud, 8 data bits, 1 stop bit, no parity

FTP Support
To access our FTP site, log on to our Internet host, ftp.natinst.com , as anonymous  and use 
your Internet address, such as joesmith@anywhere.com , as your password. The support files and
documents are located in the /support  directories.
Play GPIB for Windows 98/95
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Fax-on-Demand Support
Fax-on-Demand is a 24-hour information retrieval system containing a library of documents on a
range of technical information. You can access Fax-on-Demand from a touch-tone telephone a
512 418 1111.

E-Mail Support (Currently USA Only)
You can submit technical support questions to the applications engineering team through e-mai
Internet address listed below. Remember to include your name, address, and phone number so
contact you with solutions and suggestions. 

support@natinst.com

Telephone and Fax Support
National Instruments has branch offices all over the world. Use the list below to find the technic
support number for your country. If there is no National Instruments office in your country, cont
the source from which you purchased your software to obtain support.

Country Telephone Fax
Australia 03 9879 5166 03 9879 6277
Austria 0662 45 79 90 0 0662 45 79 90 19
Belgium 02 757 00 20 02 757 03 11
Brazil 011 288 3336 011 288 8528
Canada (Ontario) 905 785 0085 905 785 0086
Canada (Quebec) 514 694 8521 514 694 4399
Denmark 45 76 26 00 45 76 26 02
Finland 09 725 725 11 09 725 725 55
France 01 48 14 24 24 01 48 14 24 14
Germany 089 741 31 30 089 714 60 35
Hong Kong 2645 3186 2686 8505
Israel 03 6120092 03 6120095
Italy 02 413091 02 41309215
Japan 03 5472 2970 03 5472 2977
Korea 02 596 7456 02 596 7455
Mexico 5 520 2635 5 520 3282
Netherlands 0348 433466 0348 430673
Norway 32 84 84 00 32 84 86 00
Singapore 2265886 2265887
Spain 91 640 0085 91 640 0533
Sweden 08 730 49 70 08 730 43 70
Switzerland 056 200 51 51 056 200 51 55
Taiwan 02 377 1200 02 737 4644
United Kingdom 01635 523545 01635 523154
United States 512 795 8248 512 794 5678
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Technical Support Form
Photocopy this form and update it each time you make changes to your software or hardware, a
the completed copy of this form as a reference for your current configuration. Completing this f
accurately before contacting National Instruments for technical support helps our applications 
engineers answer your questions more efficiently.

If you are using any National Instruments hardware or software products related to this problem
include the configuration forms from their user manuals. Include additional pages if necessary.

Name ______________________________________________________________________

Company ___________________________________________________________________

Address ____________________________________________________________________

___________________________________________________________________________

Fax ( ___ )___________________ Phone ( ___ ) ___________________________________

Computer brand ________________ Model ________________ Processor_______________

Operating system (include version number) ________________________________________

Clock speed ______MHz   RAM _____MB  Display adapter ________________________

Mouse ___yes   ___no     Other adapters installed ___________________________________

Hard disk capacity _____MB Brand __________________________________________

Instruments used _____________________________________________________________

___________________________________________________________________________

National Instruments hardware product model __________  Revision ___________________

Configuration _______________________________________________________________

National Instruments software product ____________________________ Version _________

Configuration _______________________________________________________________

The problem is: ______________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

List any error messages: _______________________________________________________

___________________________________________________________________________

___________________________________________________________________________

The following steps reproduce the problem:________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________
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Hardware and Software Configuration Form
Record the settings and revisions of your hardware and software on the line to the right of each
Complete a new copy of this form each time you revise your software or hardware configuration
use this form as a reference for your current configuration. Completing this form accurately be
contacting National Instruments for technical support helps our applications engineers answer 
questions more efficiently.

National Instruments Products
GPIB Interface Type and Revision ______________________________________________

GPIB Software for Windows NT/98/95 Date on CD __________________________________

Programming Language Interface Version ________________________________________

Diagnostic Utility Results ______________________________________________________

Other Products
Resources Summary Report from the Device Manager

To create this report, first display the System Properties dialog box for the computer by 
double-clicking on the System icon under Start»Settings»Control Panel. Then click on the 
Device Manager tab and highlight the Computer icon. Click on the Print  button, and check the 
Print to file  checkbox in the Print  dialog box before clicking on OK .

___________________________________________________________________________

___________________________________________________________________________

Programming Environment Information

Programming Language _______________________________________________________

Compiler Vendor ______________________ Compiler Version ________________________

Application Information

DOS Application _____________Win16 Application_____________Win32 Application ______

If Win16 or Win32, method of accessing DLL (link with language interface or direct entry? ___

___________________________________________________________________________
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Documentation Comment Form
National Instruments encourages you to comment on the documentation supplied with our pro
This information helps us provide quality products to meet your needs.

Title: Getting Started with Your Plug and Play GPIB Hardware and Software for Windows 9

Edition Date: July 1998

Part Number: 321035E-01

Please comment on the completeness, clarity, and organization of the manual.

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

If you find errors in the manual, please record the page numbers and describe the errors.

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

Thank you for your help.

Name _____________________________________________________________________

Title ______________________________________________________________________

Company ___________________________________________________________________

Address ____________________________________________________________________

___________________________________________________________________________

Phone ( ___ )__________________________  Fax ( ___ ) ____________________________

Mail to: Technical Publications Fax to: Technical Publications
National Instruments Corporation National Instruments Corporation
6504 Bridge Point Parkway (512) 794-5678
Austin, TX  78730-5039
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° degrees

% percent

A amperes

ANSI American National Standards Institute

ASIC application-specific integrated circuit

B bytes

C Celsius

DLL dynamic link library

DMA direct memory access

EMI electromagnetic interference

FCC Federal Communications Commission

GPIB General Purpose Interface Bus

Hz hertz

IEEE Institute of Electrical and Electronic Engineers

in. inches

Prefix Meanings Value

m- milli- 10–3

c- centi- 10–2

M- mega- 106
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 ISA 
I/O input/output

IRQ interrupt request

ISA Industry Standard Architecture

legacy board ISA board whose system resources are chosen by changing phys
switches or jumpers on the board

m meters

MB megabytes of memory

PC personal computer

PCI Peripheral Component Interconnect

PCMCIA Personal Computer Memory Card International Association

PLC programmable logic controller

PnP Plug and Play

RAM random-access memory

resource hardware settings used by devices in a computer system, including
interrupt level, DMA channel, and base I/O address

s seconds

VCCI Voluntary Control Council for Interference

VDC volts direct current

VXI VME eXtensions for Instrumentation
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